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1 Introduction to PrintGuide 
PrintGuide discovers, monitors and configures MPI Tech PrintServers. 
The MPI Tech PrintServers are available as hardware and software 
printers. 
 
PrintGuide is your common interface to the MPI Tech PrintServers.  
PrintGuide acts as: 

 
• Configuration Tool – Once a PrintServer has been attached to 

the network, you can use PrintGuide to discover and configure 
the PrintServer. 

 
• Status Monitor - When the PrintServer is in operation, you can 

use PrintGuide to monitor the status of the PrintServer. 
 
• Maintenance Tool - If the PrintServer needs updated firmware 

this can be accomplished with PrintGuide. 
 

Note: MPI Tech hardware print servers can also be configured via a 
web browser. See section 2.5

1.1 Overview 
The initial window of PrintGuide is the Monitor View. The Monitor View lists 
the currently discovered PrintServers and their status. By selecting a 
PrintServer on the list, it is possible to see the status of its logical printers. 
 
A double-click on a PrintServer in Monitor View will cause the PrintGuide to 
upload the configuration of the selected PrintServer and open the 
Configuration View. From here you can control network settings and you 
can enable, disable, and configure logical printers. 

Figure 1 

The logical printer represents 
how the PrintServer appears to 
the printing application. 

MONITOR

NETWORK (*)

LOGICAL
PRINTER

CONFIGURE

• DiscoverPrintServers
and monitor their status.

• Enable, disable, and
configure logical printers.

• The network protocols
used for discovery and
subnets to be browsed.
• Performance tuning
(refresh rates, timeouts,
and delays).

Options | Preferences

(*) Not relevant forDocOut.

 
Each logical printer is 
configured to accept data from 
an input port, transform the 
host print data, and direct it to 
a specific output destination, 
typically a physical printer. 
 
There can be several logical 
printers for each physical 
printer. 
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1.2 Online help 
This Getting Started describes the major functions of PrintGuide. For 
details you are referred to the extensive Help provided with the 
program, which can be launched by pressing F1. 

1.3 Start PrintGuide 
Click the Start menu, point to All Programs - MPI Tech - 
PrintGuide and click PrintGuide. 

1.4 Monitor View 

 

Figure 1 

The initial screen, Monitor View, presents an overview of the 
discovered PrintServers and the status of the selected PrintServer's 
logical printers. 
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Note: Lists in Monitor View can be sorted by clicking the column 

headings. Click Configured to see the unconfigured (new) 
PrintServers at the top of the list. Click Address to sort 
PrintServers according to their address (MAC or IP). 

 
The list of logical printers shows you their status, but if you want to 
change settings for them, you have to put PrintGuide into 
Configuration View (double-click a PrintServer). 

1.4.1 Saving and loading a monitor list 

You can save the entire list of discovered devices to file at any time by 
selecting Save Monitor List from the Monitor menu. 
 
Note: In the Preferences dialog (select Preferences from the 

Options menu) you can choose to save the list automatically 
when PrintGuide is closed. Refer to the on-line help for further 
details. 

 
You can load the previously saved list of discovered devices from file 
at any time by selecting Load Monitor List from the Monitor menu. 
 
Note: In the Preferences dialog, you can choose to load the list 

automatically when PrintGuide is started. Refer to the on-line 
help for further details. 
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1.4.2 Monitor filters 

With this feature, you can define a list of filters to limit the number of 
PrintServers shown in the Monitor View. Filters can show device 
addresses within a certain range, all devices with a common part of a 
name, or all devices that are not ready etc. To define a filter, do the 
following: 

1. Press the Monitor Filter Preferences button , or click 
Preferences on the Options menu.  
A dialog is displayed asking you whether you want to import a 
few demonstration filters that illustrate how you can use 
filtering. If you select Yes (they can be removed later), the 
Preferences dialog’s Monitor Filters tab is displayed as shown 
in Figure 2: 
 

 

Figure 2 

 
2. Press the New button. 

The Monitor Filters tab changes to let you define a new filter; see 
Figure 3.  
 

3. Enter a Filter name and (if you want) a Description. 
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Figure 3 

 
4. Now set up the conditions for the filter (click on the field beneath 

the headings to see the options) and save it by pressing OK. You 
can see how a filter is defined in Figure 4. 

 

 

Figure 4 

You can export the filters to a file and you can import them from a file. 
You can also copy the filters from a network drive to your own PC. 
 
To activate or deactivate the filters in Monitor view, press the filter 

button .  
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When the filters are activated, the text above the list of detected 
devices will say: Detected Devices: (Filtered) (see Figure 1). 
 
Note: The header of the monitor list shows the number of detected 

(filtered) devices along with the total number of devices on the 
network: Devices: 22/36 in Figure 1. 
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1.5 Info Viewer 
If you right-click the mouse on the highlighted PrintServer and select 
the menu item Show Info Viewer, a window will be displayed giving 
you useful information about the selected PrintServer. You can also 
select Show Info Viewer on the menu Options. 
 

 

Figure 5, PrintServer Info Viewer 

1.6 Discovery preferences 
If PrintGuide is unable to discover a PrintServer and the PrintServer is 
otherwise running (powered on), it may be because the discovery 
preferences need to be changed. 
 
1. On the Options menu, click Preferences. 
2. Click the Network tab (See Figure 6). 
3. Enable DLC and/or TCP/IP protocol. 
4. Edit the corresponding protocol settings, as you require. 

 
Note:  The DLC protocol is supported with Windows versions 
2000 and older.  
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Figure 6 

 
Table 1 shows the connection between the discovery protocol, the 
PrintServer’s TCP/IP capabilities, and on what address (IP or MAC) the 
PrintServer will be listed under Monitor View. 
 

Discovery 
Protocol 

TCP/IP 
Disabled 

TCP/IP 
Enabled 

DLC (**) MAC (**) MAC 
DLC (**) and 
TCP/IP  

MAC (**) MAC or IP (*) 

TCP/IP none IP 

Table 1 

(*) The first one that reaches PrintGuide will appear in Monitor View. 
(**) Discovery on MAC using DLC is possible with Windows 2000 and 
older only. 
 
Note: DocOut will only appear in Monitor View if TCP/IP is used as the 

discovery protocol. If DocOut has multiple IP addresses it will 
appear in Monitor View with the first one that reaches 
PrintGuide. 
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2 Hardware PrintServers 
Once the hardware printer attachment has been installed according to 
it’s ”Installation & Operator’s Guide”, you should be able to discover it 
with PrintGuide (In Monitor View, select Monitor, Discover). 

 
The Hardware PrintServer appears in the Monitor View’s list of 
Detected Devices with either IP address or universal MAC address 
(See label attached to the bottom or rear panel of the hardware 
printer attachment). The MAC address looks like this: 00036e00483a. 
 
The DLC discovery protocol must be enabled, unless the PrintServer 
has an IP address. Please note that the DLC protocol is available only 
on Windows 2000 and older. Please refer to the manual that came 
with your print server for more information on assignment of the IP 
address.   
Refer to “1.6 Discovery preferences” if the PrintServer remains 
undetected.  

2.1 Configuring the PrintServer 
Now that the PrintServer is installed and discovered, only two 
conditions remain to be fulfilled before the PrintServer can be used for 
printing: 
 
• One or more logical printers must be enabled and configured. 

(Refer to “Example of configuring a logical printer”) 
• The logical printer's corresponding network protocol must be 

enabled and configured (refer to 2.4, Network settings) 
 
Table 2 shows some of the logical printers and the network protocol 
they rely on.  
 

Logical 
Printer 

Network 
Protocol 

AFP/IPDS (PSF) using TCP/IP TCP/IP 
AFP/ICDS (ida PSS) using TCP/IP TCP/IP 
LAN (Novell) using IPX/SPX IPX/SPX 
LAN (TCP/IP) using LPD TCP/IP 
SCS/DCA (AS/400) using TCP/IP TCP/IP 
LAN (ida MON) using 802.2 ida802.2 
AFP/IPDS (PSF) using ida HPR ida802.2 
SCS (S/390) using SNA (LU1) PU/LU 
AFP/IPDS (PSF) using SNA (LU1) PU/LU 
LAN (Windows) using NetBEUI/NetBIOS NetBEUI 

Table 2 
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2.2 Editing and saving configuration 
To edit a PrintServer’s configuration, do one of the following: 
 
• Double-click on it in the list in Monitor View 
• Highlight it in the list and select Edit Configuration from the 

PrintServer menu 

• Highlight it in the list and click the Edit Configuration  button. 
• Right-click on it in the list and select Edit Configuration from the 

menu 
 
When you finish editing, you must save the configuration. You can 
either save it in the PrintServer or you can save it in a file.  
 
To save in the PrintServer, do one of the following: 
 
• Select Save Configuration from the PrintServer menu 
• Right-click on it in the list and select Save Configuration from 

the menu 

• Highlight it in the list and click the Save Configuration  
button. 

 
To save to a file, do one of the following: 
 

• Click on the  button. 
• Select Save / Save As from the File Menu 
 
Note: When you save to a file, PrintGuide saves the original full 

configuration, followed by the changes applied to the 
configuration. 
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2.3 Example of configuring a logical printer in a 
hardware PrintServer 
1. Start the PrintGuide program  

(See: Chapter 1.3 ‘Start PrintGuide’). 
2. Locate a PrintServer on the list of Detected Devices ( Figure 7) 

and double-click it. The PrintServer is identified by its Address 
and Name.  

 

 Figure 7 
 
3. Type a Print Server Name, Contact Person, and PrintServer 

Location (Figure 8). This information is optional, but it will help 
you identify the PrintServer in the future. 
 
Note: The information in the remaining dialogs depends on the 
PrintServer and the logical printer selected. Consult the online 
help for additional information. 
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4. Locate a Logical Printer (Figure 8) that matches your 

requirements and double-click it. 
 

 

Figure 8 

5. Adjust the settings to match your requirements (Figure 9). 
Select the Enabled check box to enable the printer. 

 

Figure 9 

6. Click the IPDS tab, and adjust the settings to match your 
requirements (Figure 10). 
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Figure 10 

 
7. Then click the Printer tab to get to the Printer Settings  
8.   

 

 
9. Clear the Auto Configure Settings check box to manually 

configure the printer settings. 
10. Click the Strings tab to get the Strings Settings (Figure 11). 
11. Click Output Driver (Figure 12). 
 
Note: All dialogs shown will vary depending on the print server and 

the type of logical printer configured. 
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Figure 11 
 

 
Figure 12 
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2.3.1 Port driver settings 

 
Figure 13 

If the PrintServer selected is supporting output via network (Host2Net 
facility), a drop down menu in the Port Driver tab sheet will also 
appear. Here, you can select the appropriate port driver from a 
dropdown menu. Enter IP address and TCP/IP Port (default 9100) 
for TCP/IP Network Port Driver. 
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2.4 Network settings 
This dialog is available for hardware PrintServers only.  
 
You can enable/ disable and configure settings for various network 
protocols. In addition, you can configure the local MAC address, e-mail 
notification settings and (for some PrintServers) hub settings. 
 
1. In the Configuration menu, select Network Settings… (or just 

click the Network button) See (Figure 8). 
2. Select the Network Protocol you intend to use, and click the 

corresponding tab to configure the network protocol (Figure 
14). 

 
 

 

Figure 14 
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Table 3 lists the network protocols/tabs and gives a short description 
of their contents. 
 
 

 
Tab Description 
TCP/IP  IP address, subnet mask, gateway, host name, and 

use of BootP Server.  
NetBEUI Microsoft Windows protocol settings, NetBIOS name 

and WorkGroup.  
Simple Network Management Protocol is enabled in 
conjunction with TCP/IP.  

SNMP  

IPX/SPX  Novell NetWare protocol setting for NCP, EPS, and 
supported frame type.  

PU/LU  IBM SNA protocol settings for IBM host configuration 
(Block Number, ID Number, Remote MAC address, 
Local SAP, and Remote SAP).  

ida802.2  ida802.2 alias name. 
MAC Use of local administered MAC addresses. Tab is 

always present. 
Notification SMTP Server address, sender (PrintServer) address, 

receiver address, printer events which result in an e-
mail 

Hub LAN speed and Port#3 mode 

Table 3 

 
Note: There are no settings for AppleTalk. Hence no AppleTalk Tab 
will show when enabled. 
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2.5 Open in web browser 
Note: This is only available for hardware PrintServers. 
 
You can open the web browser directly by entering the IP address of 
the product or from PrintGuide and use it to configure the selected 
PrintServer. 
 
1. Highlight the PrintServer in the list. 
2. Right-click the PrintServer or click the PrintServer menu.  
3. Select Open in Web Browser (see the example in Figure 15). 
 
 

 

Figure 15, Open in web browser 
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2.6 Updating configuration 
You can update the selected PrintServer by sending an existing file to 
it. To do this: 
 
• In Monitor View, select Update Configuration from the 

PrintServer menu. 
 
When you select Update Configuration, a File Open dialog is 
displayed prompting for the name of the file to be sent.  
 
For all hardware PrintServers, you can send a variety of configuration 
file types. For PrintServers that support IPDS, you can send an IPDS 
Font Set file. Refer to the on-line help for further details. 

2.7 Updating firmware 
You can update the selected PrintServer’s firmware by sending an 
existing file to it. To do this: 
 
• In Monitor View, select Update Firmware from the PrintServer 

menu. 
 
When you select Update Firmware, a File Open dialog is displayed 
prompting for the name of the file to be sent.  
 
For hardware PrintServers, you can send a variety of firmware file 
types. Refer to the on-line help for further details. 

2.8 Backing up configuration 
You can make a backup of the selected PrintServer’s configuration in a 
file. To do this: 
 
• In Monitor View, select Backup Configuration from the 

PrintServer menu. 
 
When you select Backup Configuration, a Save As dialog is 
displayed prompting for the name and location of the file to which the 
configuration is to be saved.  
 
Note: When you make a backup, the whole configuration is saved, 

unlike with Save Configuration… which only saves a part of 
the configuration. Files created using Backup Configuration… 
have extension .upd. 
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2.9 Copying configuration to another PrintServer 
You can copy the currently selected PrintServer’s configuration to 
another PrintServer. To do this: 
 
1. In Configuration View, select Copy Configuration to from the 

Configuration menu. 
2. In the dialog displayed, locate and double-click the PrintServer 

to which you want to copy the configuration. 
This feature is only recommended for advanced users. 
 
 
Note: When you copy configuration to a PrintServer, its current 
configuration is overwritten and lost. 
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3 Software PrintServers 
In the following, PrintServer is synonymous with DocOut. Once the 
PrintServer has been installed according to its ”Installation & 
Operator’s Guide”, you should be able to discover it with PrintGuide 
(In Monitor View, select Monitor, then Discover). 
 
For more information on DocOut, please refer to our web site at 
www.mpitech.com/docout
 
The PrintServer is displayed in the Monitor View’s list of Detected 
Devices under its IP address. The IP address looks, for example, like 
this: 194.192.134.86. 
 
If the PrintServer remains undetected you should refer to “Discovery 
preferences”. 
 
Note: Lists in Monitor View can be sorted by clicking the column 

headings. Click Address to sort PrintServers according to their 
IP address. 

3.1 Editing and saving configuration 
To edit a PrintServer’s configuration, do one of the following: 
 
• Double-click on it in the list in Monitor View 
• Highlight it in the list and select Edit Configuration from the 

PrintServer menu 

• Highlight it in the list and click the Edit Configuration  button. 
• Right-click on it in the list and select Edit Configuration from the 

menu 
 
Note: If the PrintServer is shown in the list with a lock beside it; 

, its configuration is locked and you cannot edit it. 
This is because another user is currently editing the PrintServer’s 
configuration. Conversely, other users are unable to edit while you 
are editing. When you save the configuration or return to Monitor 
View the PrintServer is automatically unlocked. 

 
When you finish editing, you must save the configuration. You can 
either save it in the PrintServer or you can save it in a file.  
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To save in the PrintServer, do one of the following: 
 
• Select Save Configuration from the PrintServer menu 
• Right-click on it in the list and select Save Configuration from 

the menu 

• Highlight it in the list and click the Save Configuration  
button. 

 
To save to a file, do one of the following: 
 

• Click on the  button. 
• Select Save / Save As from the File Menu 

 
Note: When you save to a file, PrintGuide saves the original full 

configuration, followed by the changes applied to the 
configuration. 

3.2 Viewing configuration 
For DocOut PrintServers only, you can view the configuration. As with 
editing, this lets you view and make changes to the configuration. 
Unlike with editing, however, you cannot save the modified 
configuration in the PrintServer. You can only save in a file.  
 
To view a configuration, do one of the following: 
 
• Highlight it in the list in Monitor View and select Edit 

Configuration from the PrintServer menu 

• Highlight it in the list and click the View Configuration  
button. 

• Right-click on it in the list and select View Configuration from 
the menu 

 
Note: Even if the PrintServer is shown in the list with a lock beside it; 

, or if the PrintServer is password protected, 
you can still view the configuration. 

 
Refer to “Editing and saving configuration” for details of how to 
save the configuration to a file.  
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3.3 Password protecting configuration 
You can prevent other users from making unwanted changes to a 
DocOut PrintServer’s configuration by using password protection. 
 
The PrintServer’s default password is 'adm'. To prevent others from 
editing the configuration, you must set a new password. To do this: 
 
• In Monitor View or Configuration View, select Change Password 

on the PrintServer menu. 

3.4 Example of configuring a logical printer in a 
DocOut PrintServer 
1. Start the PrintGuide program  

(See: Chapter 1.3 ‘Start PrintGuide’). 
2. Locate a DocOut in the list of Detected Devices (The DocOut is 

identified by its Address and Name) and highlight it.  
 
This causes the list of active logical printers to be displayed for 
the DocOut printserver. See Figure 16. 
 

 

Figure 16 
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3. Locate a Logical Printer in the list that matches your 
requirements and double-click on it. 
 
PrintGuide will enter into Configuration View, see Figure 17.  

 

 

Figure 17 

4. Highlight the Logical Printer in the list and click Edit, or double-
click on it. You can also highlight it and right-click to get the 
menu shown in Figure 18, from which you can select Edit 
Logical Printer… . 
 
This causes the Configuration dialog to be displayed, see  
Figure 19.  
 

Note: This is just an example; the tabs shown depend on the type of 
logical printer selected. 

 
Figure 18 
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Figure 19 

 
5. Edit the settings to match your needs Select the Enabled check 

box to enable the Logical Printer.  
 

6. Click the IPDS tab, and edit the settings to match your needs. 
See Figure 20. 

 

 

Figure 20 
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7. Click the Physical Printer tab. See Figure 21. 
 

 

Figure 21, General setting 

 

 

Figure 22, Trays / Bins 

 
8. In the Printer Settings box, clear the Auto Configure 

Settings check box to manually configure the printer settings. 
(Figure 21 and Figure 22) 
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Figure 23  Finishing options 

 
Enable Corner / Edge Stapling and insert the PJL command for the 
actual stapling required.   
Note:  The PJL commands are printer specific. Please refer to a 
Technical Reference Manual for the actual printer model. 
 

 

Figure 24 
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9. Click the Output Driver tab (Figure 24). Here, you can select 
the appropriate port driver from a dropdown menu. Choose 
between printing to spool (Spool Driver) or to a TCP/IP 
Network Port Driver. If you print to a spool driver, you can 
choose to send the output directly to the spool queue, to print 
PDF output, to print to a file or to print to file and copy to spool. 
According to your choice, the fields in the lower part of the 
dialogue will be ready for input. Click on Help for further 
information. 

 

 

Figure 25 

 
If you choose the TCP/IP Network Port Driver, you must enter 
IP address and TCP/IP Port. (default is 9100) 
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3.5 Add logical printers to DocOut 
1. Press the Add button from the list of Logical Printers  

(See Figure 17.) 
2. This will start the Logical Printer Wizard, which will guide you 

through the operation of adding a Logical Printer. 
 

 

Figure 26 

3.6 Updating configuration 
You can update the selected PrintServer by sending an existing file to 
it. To do this: 
 
• In Monitor View, select Update Configuration from the 

PrintServer menu. 
 

When you select Update Configuration, a File Open dialog is 
displayed prompting for the name of the file to be sent. For DocOut 
PrintServers, either full or partial configuration files can be sent. Refer 
to the on-line help for further details. 

3.7 Updating license 
Note: This is only available for DocOut PrintServers with software 

version S82 063.000 (or later) installed. 
 
You must install a License Key or a License Key File to a DocOut 
PrintServer in order to authorize it.  
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For a detailed description, please refer to the below documents:  
 

• DocOut for Windows Installation and Operator’s Guide  
 Doc No.  D60363   
or to  

• DocOut Licensing Server Installation and Operator’s 
Guide. 

 Doc No.  D10564 
 
A License Key file contains can contain one or more license keys and 
their associated serial numbers. This means that if you have a number 
of PrintServers, you can authorize all of them (one by one) using the 
same file and without having to enter any numbers manually.  

3.8 Backing up configuration 
Refer to section 2.8

3.9 Copying configuration to another PrintServer 
Refer to section 2.9
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3.10 Log settings 
Note: This is available for DocOut PrintServers with software version 

S82 061.060 (or later) installed. 
 
You can choose between seeing messages in the EventViewer or 
logging them to a file. To configure the log settings, do the following: 
 
1. Double-click the PrintServer whose settings you want logged in 

the (Monitor View) list to put PrintGuide into Configuration View. 
 
2. Select Configuration, Log settings... 
 

The dialog shown in Figure 27 is displayed. 
 

   

Figure 27 

 
3. Check the boxes of your choice and enter a File Name if you 

want the messages to be logged to a file. Click OK to save your 
settings. 
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About MPI Tech 

 
MPI Tech, formerly i-data Printing Systems is a global vendor of workflow and 
output management solutions with distribution worldwide. MPI Tech develops and 
markets a world-leading portfolio of technologies and products for unique 
Document Managing and Printing solutions. 
 
With offices located in France, Denmark, Germany, UK and USA, MPI Tech 
operates in most of the world through sales and support offices and partners. Our 
partners include Hewlett-Packard, IBM, Ricoh, Xerox, Konica Minolta and Dascom. 
 
More information is available at www.mpitech.com 
 
 
Trademarks: 
Company and product names mentioned in this manual are trademarks or 
registered trademarks of their respective owners. MPI Tech cannot be held 
responsible for any technical or typographical errors and reserves the right to 
make changes to products and documentation without prior notification. 
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